This manual is property of Smart Structures, Inc. It must be promptly returned to them at any time they may so request. It is loaned to the holder for his personal information and use only, and its content shall not be disclosed by the holder to any third party. The holder shall take every precaution to prevent third parties from perusing, reproducing or copying the same either wholly or in part.

© 2012 Smart Structures Inc. All rights reserved. Neither the whole nor any part of this manual may be reproduced, stored in any retrieval system or transmitted in any form or by any means (electronic, mechanical, reprographic, recording or otherwise) without the prior written consent of the copyright owner.

SmartPile® is a registered trademark of Smart Structures Inc. The SmartPile® system is protected under U.S. Patents No. 6,533,502 and 7,637,166, with additional patents pending. Smart Structures aims to ensure that all information in this document is correct and fairly stated, but Smart Structures is not liable for errors or omissions. Specifications are subject to change without notice.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
FCC ID: V9CSP-X01D2
Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.
Introduction

Through sensors embedded in the pile, the SmartPile® system obtains accurate information on stress levels in a concrete pile from the moment it is cast. This provides the system with the unique ability to measure residual stresses during installation and provide an accurate assessment of the true conditions in the pile. Multiple embedded sensors also collect accurate wave speed measurements, allowing a higher level of pile integrity monitoring. Consequently, accurate dynamic data on the shaft friction and tip resistance is available, so that an estimate of the ultimate static resistance (i.e. capacity of the pile) can be made. To enhance safety and ease of use, its patented design allows monitoring and recording of data from up to 500 feet from the pile, with no wires to connect. Powerful PC-based software generates DOT-formatted reports, provides multi-user access with password control, and allows data review from both current as well as past projects.

The system provides the user with the following benefits:

- It provides for a high level of confidence in achieving the required driving resistance
- It eliminates PDA installation pile preparation time at jobsite
- It eliminates climbing leads at the job site for gauge installation
- It provides constant monitoring of pile driving energy
- It records pile driving data history
- Instrumentation is calibrated before every installation
- It measures pile pre-stress and driving stresses (i.e, tip stresses, residual stresses, total stresses) and pile tip resistance
- It provides for high levels of pile integrity monitoring
- It provides for an efficient means for monitoring pile re-strikes
- Instrumented piles require no special handling by the contractor
- It provides additional features for pile manufacturing and installation quality control

Following a short system introduction, this manual describes in 27 steps, the data review process with the SmartPile® system. It is important that these steps are followed strictly, and it is therefore suggested that this manual be carefully reviewed before the actual work is started, so that any questions or concerns can be addressed prior to the actual work. In case you require additional support or clarifications from Smart Structures, Inc., don’t hesitate to do this. The best way to contact Smart Structures is by calling (866) 640-2993 and then entering 1 for support.
Contents

Introduction .................................................................................................................................................. 3
System Overview ......................................................................................................................................... 8
  Off-site Preparation of Installation Kit .................................................................................................... 8
  Activate System ......................................................................................................................................... 8
On-site Installation of Items included in the Installation Kit ...................................................................... 8
Check System Prior to Pile Casting ............................................................................................................ 9
Pour Concrete .............................................................................................................................................. 9
Check System after Pile Casting .................................................................................................................. 9
Transport finished SmartPiles® to the Job Site .......................................................................................... 10
Data Acquisition ........................................................................................................................................ 10
Data Review ................................................................................................................................................ 10
Using SmartPile® Review .......................................................................................................................... 12
  Get Familiar with the Manual .................................................................................................................... 12
  Get Started .............................................................................................................................................. 12
  Start SmartPile® Suite / SmartPile® Review ................................................................................................ 13
Set the Initial Data Directories ................................................................................................................... 13
SmartPile® Application Licensing ............................................................................................................ 14
SmartPile® Definitions .............................................................................................................................. 14
SmartPile® File Types ................................................................................................................................ 15
SmartPile® Review Modes ......................................................................................................................... 15
Use SmartPile® Review in Live Mode ........................................................................................................ 16
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SmartPile® Review in Offline Mode</td>
<td>16</td>
</tr>
<tr>
<td>Unpack a Previously Created Session</td>
<td>17</td>
</tr>
<tr>
<td>Load a Previously Created Session</td>
<td>18</td>
</tr>
<tr>
<td>Initial Session Run Through</td>
<td>19</td>
</tr>
<tr>
<td>Data Review Summary</td>
<td>20</td>
</tr>
<tr>
<td>Analysis Tabs</td>
<td>21</td>
</tr>
<tr>
<td>Review Configuration Data</td>
<td>22</td>
</tr>
<tr>
<td>Review Raw Blow Data</td>
<td>22</td>
</tr>
<tr>
<td>Review Top Gages Data (Force/Velocity &amp; Wave Up/Down)</td>
<td>23</td>
</tr>
<tr>
<td>Review Tip Gages Data (Unloading Point Capacity – Force / Velocity)</td>
<td>24</td>
</tr>
<tr>
<td>Review Summary Data</td>
<td>25</td>
</tr>
<tr>
<td>Generate Session Report</td>
<td>26</td>
</tr>
<tr>
<td>View Session Catalog Index</td>
<td>27</td>
</tr>
<tr>
<td>Measurement Comparison Flagging</td>
<td>28</td>
</tr>
<tr>
<td>Export Data</td>
<td>29</td>
</tr>
<tr>
<td>Importing Comparison Files</td>
<td>29</td>
</tr>
<tr>
<td>End a Review Session</td>
<td>30</td>
</tr>
<tr>
<td>SmartPile Suite: Starting SmartPile Acquisition</td>
<td>30</td>
</tr>
<tr>
<td>Reviewing SmartPile® Documentation</td>
<td>31</td>
</tr>
<tr>
<td>Specific User Instructions</td>
<td>33</td>
</tr>
<tr>
<td>Reviewing a StateStamp®</td>
<td>33</td>
</tr>
<tr>
<td>Display Screen Viewing Options</td>
<td>34</td>
</tr>
<tr>
<td>Sharing Session Data</td>
<td>34</td>
</tr>
<tr>
<td>SmartPile® Fix Utilities</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>SmartPile® Fix Utilities – Remove Empty Blows</td>
<td>35</td>
</tr>
<tr>
<td>SmartPile® Fix Utilities – Update Pile Penetrations</td>
<td>36</td>
</tr>
<tr>
<td>SmartPile® Fix Options – Review Bad Blows</td>
<td>37</td>
</tr>
<tr>
<td>SmartPile® Fix Utilities – Renumber/Combine Blows</td>
<td>38</td>
</tr>
<tr>
<td>SmartPile® Fix Utilities – Change Project &amp; Location</td>
<td>39</td>
</tr>
<tr>
<td>SmartPile® Fix Utilities – Purge Sessions</td>
<td>40</td>
</tr>
<tr>
<td>Additional Capabilities</td>
<td>41</td>
</tr>
<tr>
<td>Download the SmartPile® Review Application</td>
<td>42</td>
</tr>
<tr>
<td>Appendix 1 – Background Paper</td>
<td>43</td>
</tr>
<tr>
<td>Appendix 2 – Interpretation of SmartPile™ EDC Measured Pile Integrity (MPI) Results</td>
<td>45</td>
</tr>
<tr>
<td>Appendix 3 – SmartPile™ EDC Reports</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>63</td>
</tr>
</tbody>
</table>
Part 1
System Overview
System Overview

Off-site Preparation of Installation Kit
In most cases an Installation Kit will be prepared before the installation technician arrives at the casting yard (“off-site”) to speed up the installation of the system on-site.

If for whatever reason an Installation Kit has not been prepared, and instead loose components have been shipped to the casting yard, additional preparation work will be required prior to the physical installation of the system.

Activate System
If pile casting is expected within the 3 days from the preparation of the Installation Kit, the preparation of the Installation Kit includes system activation by connecting the State Stamp Battery properly to initialize the Dataport. After the Dataport access cover has been put back into place, colored tape is placed over the screw heads to clearly mark that the Dataport has been activated. The tape also ensures that concrete is kept out of the screw head slots when the piles are poured.

On-site Installation of Items included in the Installation Kit
In the casting yard, the items included in the Installation Kit are installed. This includes installation of the Suspension and Dataport Assemblies as well as connecting all these items using the Tip Extension Cable. The work also includes proper dressing of all exposed cables.
Check System Prior to Pile Casting
Prior to casting, the installation of all items is inspected and checked. Once verified, the SmartPile® Workstation is connected to the system to verify its functionality and performance. If the system operates correctly, a Pre-cast State Stamp is issued.

If applicable, epoxy can be applied to the Dataport housing before pile casting.

Pour Concrete
While pouring the concrete, special attention must be given to ensure that the SmartPile® system is not damaged either by having concrete dropped right on top of the sensing elements, or by careless vibrator use.

Check System after Pile Casting
After the pour has been completed, the SmartPile® Workstation is once again connected to the system to verify system functionality and performance. If the system operates correctly, a Post-cast State Stamp is issued. A copy of this State Stamp can be given to the appropriate yard personnel for quality and integrity tracking purposes.
### Transport finished SmartPiles® to the Job Site

#### Data Acquisition

The data acquisition using the SmartPile® Workstation is described in the Data Acquisition Manual.

It is essential that the system is properly configured prior to the start of the data collection to ensure that the data is recorded correctly. This configuration as well as the actual data recording is done with the Data Acquisition software within the SmartPile® Suite.

#### Data Review

The analysis of the recorded data, either during data acquisition on site or at a later date in the office, is described in the Data Review Manual.

This review is done using the Data Review software, running either stand alone or within the SmartPile® Suite. This software also allows you to perform installation monitoring analysis (including pile capacity calculations) and pile integrity analysis, as well as generate summary report.

Additional capabilities of the system beyond driven pile installation are covered at the end of this manual.
Part 2

Data Review
# Using SmartPile® Review

<table>
<thead>
<tr>
<th></th>
<th><strong>1. Get Familiar with the Manual</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>It is very important to carefully review this manual before using the software, so that any questions or concerns can be addressed prior to encountering issues.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th><strong>2. Get Started</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Make sure that you have installed the latest version of SmartPile® Review on your computer. If you are using a Workstation running SmartPile® Suite, you can assume that this is the case. If not, go to the Smart Structures portal to verify that you are using the latest version (please follow <strong>Specific User Instructions Item E</strong> at the end of this manual).</td>
</tr>
<tr>
<td></td>
<td>This manual is applicable to SmartPile® Review version 4.0 and higher. Any older versions of Review need to be updated at this time.</td>
</tr>
<tr>
<td></td>
<td>Finally, create a ‘SmartPile’ folder in your ‘My Documents’ directory.</td>
</tr>
</tbody>
</table>
3 Start SmartPile® Suite / SmartPile® Review
From the Windows Start menu, start the program with one of the following selections:
Start  Programs  SmartPile® Suite 4.0  SmartPile Suite 4.0
or
Start  Programs  SmartPile® Review 4.0  SmartPile Review 4.0

4 Set the Initial Data Directories
The first time you start up SmartPile® Suite/Review, you will be prompted to identify where the SmartPile® data will be located (red box). Browse to highlight the target folder in the window, and then click on the Choose Dir Button to confirm. The recommended location is the ‘SmartPile’ folder in your ‘My Documents’ directory (see step 3).

Note:
If you wish to relocate this data at a later time, you can select a new location using the following menu option:
File  Change Default Data Directory
4a SmartPile® Application Licensing
With Release 4.0 of SmartPile Suite and Review, valid license keys from the SmartPile Portal must be provided. At startup, the system will appear idle, but actually current licenses (based on the Stations’ Workstation Key). You will note a blinking License Expiration, which is the confirmation-in-process indicator.

Licenses, Keys, and Expirations are managed by a Workstation Key by Smart Structures. Please contact SSI if you have problems with your Licensing with any of the SmartPile® Tool Suite (Review, Suite, Match, or Simulate).

5 SmartPile® Definitions
Session Configuration Data is the data entered during the Data Acquisition phase before starting a Session. It includes User (ID) Data, Project Data, Structure (Location) Data, and Pile Configuration Details and Driving Criteria.

During a Session, Raw Blow Data are recorded, and a completed Session includes both Session Configuration and Raw Blow Data.

- SmartPile® Acquisition is the tool used to perform all necessary tasks to create a complete Session file.
- SmartPile® Review is the tool to interpret the Raw Blow Data and also acts as a Session viewer.
SmartPile® File Types

Within SmartPile Suite/Review, the following file types are used:

In Acquisition:
- usr - User Configuration File
- prj - Project Configuration File (Project details, down to the physical pile installation location)
- spd - Pile Configuration File (including manufacturing dimensional information and sensor calibration data)

Data Files (Review and Acquisition):
- tsp – State Stamp File
- bdf - Blow Data File (measured response during installation)

Full Configuration File:
- ssn - Session Configuration File, combined Drive details to the raw blow data

SmartPile® Review Modes

SmartPile® Review has 2 modes of operation:

- Live - In this mode, SmartPile® Review is combined with SmartPile® Acquisition to provide real-time monitoring data analysis.
- Offline(Review) - In this mode, SmartPile® Review is run stand-alone to replay and report on a previously recorded Session.

Regardless of mode, SmartPile® Review performs the same calculations and reports the same kind of results. SmartPile® Acquisition stores raw sensor data, while SmartPile® Review processes this data set and generates reports.

To better understand the use of SmartPile® Review in conjunction with Acquisition, please refer to the SmartPile® User Manual - Data Acquisition.
Use SmartPile® Review in Live Mode

When in Live mode, the Review output screens can be used to assess pile driving progress, pile integrity, and system status. Allow the Session to continue until monitoring is complete (making sure to properly record the pile penetration markers). Once complete, the Session can be rebuilt for further review and analysis.

To use SmartPile® Review to review the captured data during an extended monitoring break of the work in progress, use the following steps from the Data Acquisition mode:

- Take the system out of session (see step 26 of the Data Acquisition Manual), including possibly moving the Collect Data slider to “Idle”
- Switch to SmartPile® Review (see step 23 of the Data Acquisition Manual)
- Select File -> Rebuild Pile Blow Index
- Use PageUp, PageDown, and Ctrl-S to review the currently collected Blow Data File set

To restart monitoring, put the system back in session (see step 27 of the Data Acquisition Manual), including (if applicable) moving the Collect Data slider to “Collect Data”. When a new blow arrives, the system will automatically move to the end of the previous Blow Count, and again begin to display the new blows coming in.

Use SmartPile® Review in Offline Mode

To properly review and assess the results of a specific Session in Offline mode, session data need to be loaded either by:

- Unpacking a previously created Session or
- Loading a previously created (prior) Session

To ensure that the Session is properly loaded, the user needs to first select the Clear Current Session option from the pull down menu before attempting to load another Session.
Unpack a Previously Created Session

By selecting the **File -> Unpack Drive Session** menu option (red box), the user can unpack a compressed Session file. When selecting this option, the SmartPile® system will automatically unpack the selected *.zip file into the local SmartPile Project Directory, and load the Session for review. This is indicated by the **Review Session Loaded** indicator light turning green (see previous step).

Note that the system will prompt the user to delete/overwrite data if a conflicting file is found to exist while unpacking the selected *.zip file.

SmartPile® Review also provides a means for creating a compressed Session Data file to allow the data to be shared with other users, or transferred to other computers. This is done by selecting **File -> Pack Drive Session** menu option. When selecting this option, the resulting packed file is loaded into a *.zip file in the local SmartPile Project directory.
Load a Previously Created Session
By selecting the **Session Configuration** menu option (red box), the most recently loaded Session Configurations (up to 25) are shown (which obviously have already been unpacked). The user can either select one of these configurations, or select the **Select Session Configuration**, which will allow the user to browse for other Sessions.

Once the selected Session is successfully loaded, the **Review Session Loaded** indicator will turn green (blue box), and a pop-up window showing the number of blows that have been indexed and loaded will appear very briefly, after which the following message box will appear (which is further described in step 12):

The selected and now loaded Session information regarding User, Project, Location and Pile Configuration details can be viewed by going to the **Session Configuration** Tab.

**Note:**
Sessions are created or assembled during monitoring as part of the SmartPile Data Acquisition process. When selecting a saved Session Configuration, all aspects of the information entered or collected during monitoring (User, Project, Location, Calibration, ID, etc.) is loaded along with the associated Blow Data Files.
Initial Session Run Through

To ensure the highest accuracy of the results and before any random analysis of individual blows is conducted, SmartPile® Review requires that the individual blows are first reviewed sequentially from the first blow until the last, and as this is done the overall Session Data File is created.

After selecting and loading a Session, this review can be done either manually (by stepping through successive blows using PageUp, PageDown, or by loading blows individually using the Load Button), or automatically (by selecting the File -> Start/Stop Session AutoRun menu option, or using the Ctrl-S hotkey).

When using the automatic review, the play-back speed of the Review Session can be configured in the Session Catalog Tab using the Auto Delay field (red box). The number selected represents the play-back delay between blows (in seconds).

To speed up the automatic review, the system can save processing time by not displaying the graphical results for a recurring set interval block of blows. Note that the results will still be calculated, just not displayed on the initial run-through. The number of consecutive blows that should be skipped is specified in the Display Skip field (green box). The default value for this field is 0.
Data Review Summary
After the initial Session run-through, the raw data interpretation results are ready for review. Tabs are provided to present the Configuration (see step 15) and Raw Blow Data, as well as various derived values for each Blow Data File in graphical form:

- **(Raw) Blow Data** - Strain and Accelerometer sensor data display (see step 16)
- **Top Gages** - Force-Velocity and Wave Up-Wave Down display (see step 17)
- **Tip Gages** - Force-Velocity and Unloading Point display (see step 18)
- **Summary Data** – Capacity, Stresses, Integrity and Displacement data (see step 19)
Analysis Tabs
To minimize screen change requirements and simplify viewing during monitoring; key pile status calculations and other indicators, including diagnostic information (all in the form of Analysis Tabs), are located on the right hand side of the screen (red box). The Tabs are labeled as follows:

- **Configuration** – providing a summary of the configuration data;
- **Calculations** – providing numerical results for some key calculation points not visible in graphical displays;
- **Capacity** – providing a comparison of fixed Case method capacity results vs. UF method results. Key pile health indicators are also numerically displayed.

To simplify result interpretation during real-time monitoring, the average calculated capacity (using the selected calculation method) between the last and the current pile marker entry (the so-called DBRef+1 value) as well as the average calculated capacity between the next-to-last and the last pile marker entry (the so-called DBRef+2 value) are also displayed (blue box). If these values are greater than or equal to the Nominal Bearing Resistance entered by the user in the Pile Data sub-Tab, the field will turn green. If both fields turn green (signifying 2 pile marker increments of achieved bearing), the Nominal Resistance Achieved indicator will also turn green.

The system will also check for a “pile refusal condition”, i.e. when the DBR value increases less than 2 inches in 40 blows. In that case the Nominal Resistance Achieved indicator will automatically turn green, irrespective of the calculated capacity values logic described in the previous paragraph. If the system indicates refusal, the user should also confirm the condition is true before the pile driving is ended.

Finally this tab includes the so-called MPI value. For the interpretation of this parameter please refer to Appendix 3.

- **Diagnostics** – Provides a consolidated view of the SmartPile® *Acquisition Accel / Strain Data* Tab diagnostics information. Similar content is also contained in the *State Stamp* Tab.
Review Configuration Data

Under the **Session Configuration** Tab, the Review program presents the Configuration details for the respective installation Blow Data Files under analysis in three Sub Tabs (red box):

- User Information
- Project Details
- Pile Data
- (Driving) Criteria Including Allowable Stresses
- (Optional) Pile Inspector Details

Review Raw Blow Data

The **Raw Blow Data** Tab represents the filtered accelerometer and strain sensor Blow Data File data for all Sensor Packs enabled in the Session Configuration.

The data displayed in this view can be adjusted in various ways as described in **Specific User Instructions Item B** at the end of this manual. In addition, the Top and Tip vertical cursors can be independently moved by right clicking on it, and dragging it into position. The cursors relative spacing can be locked by moving the Hold slider to the Hold position (red box). This aids in wave speed and reflection related periodic analysis.

Data channels can be disabled from the calculations by clicking on the active indicator light next to the trace color legend in the upper right hand corner of the display. This can be done in response to any signal errors indicated by the system, and confirmed by the user. It should be noted that disabling a data channel will automatically disable the other data channel from the same Sensor Pack in calculations involving both.
Review Top Gages Data (Force/Velocity & Wave Up/Down)

For the centroidal reading analysis associated with the Sensor Pack(s) located at the top of the pile (Top Position), the Force and zVelocity traces for the associated Blow Data File are displayed, along with a proportional view of relative calculated displacements for the pile top and tip in the lower right.

Below this display are the corresponding Wave Up and Wave Down analysis traces for the same file. Both displays are provided to help the user make an educated assessment on the pile condition.

Similarly to what was described in step 16 above, the T1/T2 vertical cursor relative spacing can be locked at 2L/c by clicking the Cursor Lock indicator (red box). Clicking on, and holding while moving the T1 (left) cursor aids in wave speed and reflection related periodic analysis.

It is beyond the scope of this manual to teach wave mechanics theory as it applies to driven pile foundation analysis. If the user would like additional theoretical training in this subject area, please refer to Appendix 1.
Review Tip Gages Data (Unloading Point Capacity – Force / Velocity)
For the centroidal reading analysis associated with the Sensor Pack(s) located at the tip of the pile (Tip Position), the Force and zVelocity traces for the associated Blow Data File are displayed, which are used as part of the tip resistance analysis.

Above this display, the Unloading Point based tip capacity derived from the measured tip resistance is displayed. This is used as part of the composite UF capacity analysis method (UF method). The Unloading Point Soil Rate Factor can be adjusted (red box) based on the soil properties. The options are sand (default), rock, silt, and clay. In addition, the Damping Averaging can be disabled, but it is recommended that this not be done.

Both displays are provided to help the trained user make an educated assessment on the pile condition at the tip.

There are 2 simultaneous capacity calculations performed as part of the Blow Data File analysis:

- **Fixed Case Method** - using a user selected fixed static Jc value
- **UF Method** - combines a calculated Jc capacity at the pile top, with the static tip resistance derived from the Unloading Point

The numerical results of either method can be displayed graphically by selecting the desired method in the Capacity Analysis Tab (purple box). Both capacity calculations however, are saved as part of the Session report.
Review Summary Data

The Summary Data Tab provides simultaneous graphical displays of various key monitoring results and pile health historical details. The displays are, starting in the upper left hand corner and moving clockwise:

- Pile Capacity vs. Blow Count
- Stroke and Energy vs. Blow Count
- OR Tip Preload Delta and CSB Difference (yellow box)
- Stresses (compressive and tensile) vs. Blow Count
- Blow Count vs. Pile Marker Increment

It should be noted that the accuracy of the calculation results are dependent on the pile marker displacement details being recorded correctly during monitoring.

In addition, the fields preload Delta Top/Tip (red box) display the measured change (relative to before installation) in the static strain readings (in units of microStrains) measured in the pile core at the respective positions. A negative value indicates a loss of pre-stress (towards tension), and positive indicates additional compressive preload. These measured changes converted to residual stresses can be added to the respective calculated stresses (Top/Tip) by selecting the Sum Button (purple box) in the Capacity Analysis Tab.

Additional capabilities of the system beyond driven pile installation are covered in Specific User Instructions Item E at the end of this manual.
Generate Session Report
A Session Report can be created at the end of reviewing (processing) a loaded Session. At the conclusion of processing the last Blow Data File contained in the Session, the system will prompt “Processing Complete: Generate Session Report?”

- Selecting **Report** will populate the appropriate calculation results fields in the **Session Report** Tab.
- The user will then be asked to define the directory where the Excel Workbook will be saved. By selecting **Cancel**, the user will have the opportunity to edit the **Averaging** field for the reported results display averaging, if so desired.
- The user can define the delineation and quantity of individual end of drive blow calculation details to be included in the report and also whether the report is in the DOT format (red box). **Note:**
  The calculated results exported will be average values within pile marker increment boundaries up to the user selected end of driving details delineation, except for Tension (TSX), which will be a maximum recorded value within the respective pile marker increment entries.
- Clicking on the **Generate Report** Button will export the results displayed in the **Session Report** Tab to a small Excel Workbook file that can be used for future review and post-processing. By not selecting DOT Report Format, the user can export the same basic calculated results, but minus the graphs, for later use in a user generated custom report format or template. Appendix 4 of this manual contains samples of the different report formats.
View Session Catalog Index
The Session Catalog Index can be viewed from the Session Catalog Tab. The user can use this screen to:

- Display a specific Blow Data File in the Catalog Index by clicking on it from within the index list, and then using the Page Up or Up Arrow Button (purple box) to load.

- Individual Blow Data Files can be removed (or restored) from analysis by clicking on the selection, and clicking either the Exclude or Restore Buttons on the right (red box). The selection is reversible.

- The Session can be configured to auto-run at a predefined display delay interval using the entered Auto Delay field value. Starting and stopping can be toggled by clicking the Auto Increment Button (blue box), or the Ctrl-S hotkey.

- Alternately, after first running through the entire Session; individual Blow Data File results can be viewed on each of the Tabs separately by directly entering the specific Blow Number, and then clicking on the Load Button (green box). This action will only update the display of the Tab currently visible. If additional display details are required for the Blow Data File, select the desired Tab and then click on the Load Button again.
**Measurement Comparison Flagging**

Several levels of data integrity checking are performed on the incoming raw sensor data. The intent is to identify and ignore, rather than delete suspect blows captured during the monitoring process. Incoming Blow Data Files are processed and analyzed based on several established criteria including:

- Accel/Strain proportionality
- Accel and Strain balance (in case of SP_601 configuration)
- Accel orientation
- Accel Tip/Top reflection decay

The default is full checking enabled, and any blows identified by the system as invalid are indicated on the main program banner in the lower right (red box).

If the user questions the systems interpretation results, the user can select to disable or override some or all of the measurement comparisons flagging by left-clicking in the selection window on the **Raw Blow Data Tab** (purple box). It should be noted, however, that bypassing any level of data integrity checking will be indicated as part of the Session Report.

As an additional level of error detection, the software looks specifically for the presence of a mechanical impact interference installation between the pile and the surrounding support structure (incl. the hammer and leads) during installation. Because the pile is fully instrumented, it is important that the only dynamic waveforms within the pile are those generated by the pile driving hammer and that these waves propagate through the hammer cushion in a longitudinal fashion. If any internal waveform artifacts (e.g. those generated by unsecure metal hammer leads slapping the pile, the pile slapping the template due to lateral stresses, or a poorly aligned hammer helmet contacting the top side of the pile) are detected, a flashing red indicator labeled “mechanical error” will appear (black box) so that corrective action can be initiated immediately.
23 Export Data
There are several options to export data (red box). The options include:

- **Create Blow Comparison Template** and import PDI® blow data, either at 5 kHz or 10 kHz (see step 24)
- **Create Session Comparison Template** and import PDI® results (after the Session has been run)
- **Export Filtered Blow Data to XLS** (@ 5KHz or 10KHz)

The appropriate option can be selected from the Import/Export pull down menu.

24 Importing Comparison Files
An Excel template/macro has been developed that allows the user to import PDI® Session Data for comparison purposes. The PDI export assignments should be set as follows:

- Q1=RX6
- Q2=RX4
- Q3=RX5
- Q4=TSX
- Q5=CSX
- Q6=CSB
- Q7=STK
- Q8=EMX
- Q9=BTA

Specific details regarding the process are found in the *Introduction* Tab (first worksheet) of the generated comparison file. These details are also included as Appendix 2 in this manual.
End a Review Session
To properly end a Review Session, it is strongly recommended that the Session is cleared from the system by selecting the following menu option: Session Configuration → Clear Current Session (red box).

Upon completion, the program can be ended by hitting the Close Button (purple box).

SmartPile Suite: Starting SmartPile Acquisition
SmartPile Acquisition must be launched through SmartPile Review. To launch SmartPile Acquisition and create a live capture mode Session within Review, select the following menu options:

- Session Configuration → Clear Current Session (Recommended)
- Acquire Data → Open SmartPile® Acquisition

Refer to the SmartPile® User Manual - Data Acquisition for more details.
Reviewing SmartPile® Documentation

The SmartPile® Software Suite provides user access to SmartPile® Review, Acquisition and Installation documentation which can be viewed when running the respective application. Adobe Acrobat Reader must be installed in order to use this feature.

All SmartPile® User Manuals are available through the drop down Help Menu (red box).

Manuals include:

1. The SmartPile® Review User’s Guide
2. Advanced Tip Processing Guide

As well the current Station Station Key (From Windows 7) are included along with the revision and build date.
Part 3

Specific User Instructions
Specific User Instructions

Reviewing a StateStamp®
State Stamps are sets of data captured to:

- verify system installation connectivity
- confirm static sensor reading levels within pre-defined ranges
- collect system configuration information prior to, and during the manufacture of concrete pilings.

The State Stamp is mainly provided to verify the system when piles are being manufactured. The State Stamp can also be useful at the job site as a quick and easy way to quickly capture critical pile health detail information.

A State Stamp only requires the user to input a slightly reduced Pile Configuration that includes Project Details (using the Casting Yard as the designated Project Location), and (only) the basic pile mechanical details captured at the time of manufacture.

A saved StateStamp® can be viewed using the following menu option: File → Review StateStamp® (red box).

The system will prompt for a file location; browse to locate, and double-click on to select and load.

When a StateStamp® is loaded, the system displays key health and calibration data for the DataPort® in the Diag Analysis Tab (purple box).

Alternately, a screen shot of the State Stamp, stored as a *.jpg image in the SnapShots folder in the SmartPile directory, can be viewed using any available suitable program.
Display Screen Viewing Options
There are several ways to manipulate/adjust many of the SmartPile® Review displays located throughout the application. These features provide for many display option capabilities. A summary of the display control points are listed below, and include:

1. Using the (time base) Zoom, and (delayed time base) Slider bars
2. Using the vertical Scale adjust
3. Directly manipulating the display ranges (upper and lower ends)
4. Using the Native Graphics Controls
5. Clicking on the Reset Graphs radio button

Sharing Session Data
SmartPile® Review contains a Publish File transfer utility that is used to move selected items up to the Smart Structures Customer Portal using background CPU resources. This allows the user to do other tasks, while the identified transfer takes place in low priority. Using the Publish Application menu option (red box), the following selections are available from the pull down menu:

- Session Report
- Drive Data
- Any Item

All published data is based on the currently loaded session. Captured data and reports can also be uploaded directly to the Portal for customer review (https://smartstructures.thingworx.com/Thingworx/).
SmartPile® Fix Utilities

A series of utilities exist within SmartPile® Review to edit and correct details about the currently loaded Session or perform routine maintenance (cleanup). These utilities are intended to correct or update Session Configurations when an entry error was made during the setup process in Acquisition or mistakes were made during data collection (such as incorrect blow displacement).

The utilities allow the user to:

- **Remove Empty Blows** – Cleanly remove empty blow files saved inadvertently due to an improperly set trigger level; this utility must be run before any other Session editing is done.
- **Update Pile Penetrations** – Edit pile marker increment details or blow distributions; this utility must be run second after the removal of the empty blows, but before any other Session editing is done.
- **Renumber/Combine Blows** - renumber blows sequentially to combine with other session data when blows are collected on two stations.
- **Change Project & Location** - Edit Project, Location, Structure, or Pile (number) details.
- **Purge Sessions** – Remove stored Sessions from the identified session thereby freeing up disk space.

Apart from the Review Bad Blows utility (which is accessed directly from the menu), these utilities can be accessed using the menu option: File -> Session Fix Utilities (red box) and then selecting the appropriate tab (black box).

**Note:**

It is recommended that these utilities are run in the sequence listed above, but it is absolutely essential that the removal of the empty blows and the updating of the pile penetrations is done as the first and second fix, followed by a Session Run Through and the review of the bad blows (see box D3).

When these utilities are run, they supersede/replace any existing data files and Session Configuration details. As such, Session Fixes should be performed ONLY AFTER the raw Session data has been backed up or archived (in case a return to original is required) and BEFORE any data is shared with other users.
**SmartPile® Fix Utilities – Remove Empty Blows**

If the trigger was set/reset improperly or the data collection was not turned off at the right moment, the session will include a number of blows that add to the blow count but don’t provide any capacity or health data. The Remove Empty blows fix allows the user to remove these empty blows and renumber the blows that remain by clicking on the **Remove Empty Blows** button (red box).

Before the program will perform this utility, the user will be asked whether a back-up should be created of the blow files (see the note in box D), after which the empty blows are removed from the drive and the blows are renumbered. The progress of this activity is displayed in the **Blows Processing** box (green box).

As stated on the utility screen, the program will identify a blow as an empty blow if the recorded response is a (nearly) flat line. The user can define the channels that will be checked as part of this effort and also what constitutes a flat response (blue box). It is recommended that the default settings (all channels and the number 40) are used while performing this utility.

After the utility has been run the blows identified as empty will be listed on the screen (purple box).

If no other utilities need to be used, the user can click on the **Quit** button (black box). Please note, however, that this will cause the session to be cleared and before the review can continued the session should be reloaded (see step 11), followed by a Session Run Through.

**Note:**
The next utility applied should be updating the pile penetrations. If this is not required, the user should click on the on the **Quit** button to reload the Session and perform a Session run Through before any other utilities are applied.
Specific User Instructions

SmartPile® Fix Utilities – Update Pile Penetrations

During data collection, it is important that the operator/user accurately collect the pile displacements as this information is used for calculations and reporting. Sometimes errors occur in the process and it is necessary to adjust the blow increments for consistency and accuracy.

Typical indicators of bad pile penetrations can be found in the output reports (where increments do not follow the typical displacements sequence) and can be confirmed by monitoring the User Input Displacement on the Configuration Tab in SmartPile Review (lower left above blow timestamp information).

The Update Pile Penetrations utility can be used to correct these problems:

1. Process the current session blows (by clicking on the Process Blow Increments button) to create a histogram of the blows at all captured penetrations along with an (initial) adjustment table; missed/skipped penetrations are populated with a zero blow count.
2. Update the blow counts at the given penetrations in the table (red box). Note that blows are handled sequentially, which means that the starting blow at Depth N will always be less than the starting blow at Depth N+1. Also, every change to the table results in a refresh of the update array and blow histogram.
3. Ensure that all blows are accounted for by monitoring the blow count difference that is calculated and displayed (blue box); whenever this number is zero all blows are accounted for.
4. Right clicking in table will allow the user to enter additional rows/displacements or delete rows; however, this is not recommended.
5. After entering the corrected information start the utility by clicking on the Commit Changes button (purple box). The progress of this activity is displayed in the Blows Processing box (green box) and Updating Count.
6. Once the processing is done, clicking on the Quit button (black box) will cause the session to be cleared and before the review can continued the session should be reloaded (see step 11), followed by a Session Run.

Before the program will perform this utility, the user will be asked whether a back-up should be created of the blow files (see the note in box D). Once again, it is strongly recommended that this is done.
SmartPile® Fix Options – Review Bad Blows

Radio interference, bad trigger, and hammer startup/shutdown can all produce data that is not useful for calculations and reporting. These so-called Bad Blows are automatically identified by the software and specifically left out of calculations. In addition SmartPile® provides a means of reviewing and even deleting them from future processing.

Unlike the other Session Fix Utilities, this fix option is accessible in SmartPile Review AFTER the session is run to completion. This feature is also different than removing (or restoring) Individual Blow Data Files from analysis using the Session Catalog Tab (see step 21), in that the software specifically scans for blows flagged as bad, skipping all others until the end of the drive. The goal is to quickly review and optionally delete all bad/suspect blows in the drive.

To perform a bad blow review:

1. Load and run a drive session
2. At the completion of the session run, start the bad blow review by using the menu option: File -> Review Bad Blows (red box), which will display the first bad blow on the screen
3. Along with the bad blow, a separate navigation/update window is displayed that provides the user with three options to proceed (purple box):
   - **Delete and Continue**: Delete the blow displayed on the screen and continue with the review of the bad blows;
   - **Ignore and Continue**: Maintain the file of the blow displayed on the screen and continue with the review of the bad blows;
   - **Done**: End the review of the bad blows.

Once complete (done) Blows are removed from subsequent listing and processing, but the remaining good blows are not renumbered.

**Note:**
This Session fix should be applied after removal of the empty blows and the updating of the pile penetrations, but before any other fixes are applied.
SmartPile® Fix Utilities – Renumber/Combine Blows

When collecting data on two different acquisition stations for the same pile, the user will end up with two sets of blow data, each starting with blow 1. This fix utility will allow the user to renumber blows so sets of blow data can be combined as follows:

1. Identify the last blow of the original drive session (note the number).
2. Identify the drive session that need to be combined with the original drive session in the Target Directory box (green box). It should be noted that this utility will only function if both sessions have the same radio ID (which should be the case since the sessions contain data collected from the same pile).
3. Enter the number of the last blow of the original drive session (see step 1) in the Blow Adjustment box (red box).
4. Begin the renumbering by clicking on the Renumber Blows button (purple box).
5. Once completed, you can copy the updated blows (using the Windows File explorer) to the Original Blows Directory and rerun the drive session with the both sets of blow data.

Note that if no Blow Adjustment is entered (i.e. left at zero), then nothing is done. Also, the user can enter a negative number in the Blow Adjustment box.

If no other utilities need to be used, the user can click on the Quit button (black box). Please note, however, that this will cause the session to be cleared and before the review can continued the session should be reloaded (see step 11)

Subsequent to these changes, it is recommended that the updated drive session be packed and submitted to the portal.
SmartPile® Fix Utilities – Change Project & Location

The Project Name, Location, Structure, and Pile Number all uniquely identify the placement of data on the hard drive and cannot be changed anywhere but in this utility. It should be noted that changes made by this utility alter not only the Session details but also the directory names.

To alter the project and location data, the corrected information must be entered (red box), after which the utility can be started by clicking on the Update Details button (purple box).

As part of the updating process, the utility will:

1. Automatically modify the name of the Session Configuration File to reflect the revised project and location data (green box).
2. If the session configuration being processed is an older file format (Pre-3.75), ask the user whether or not the file should be saved for the latest version of the software or a previous version. It is suggested that the latest file format is always used.
3. Relocate all Blow data to the new Project/Location/Structure/Pile directory. The move progress is displayed in the Blue Updating indicator at the lower right of the utility screen.

If no other utilities need to be used, the user can click on the Quit button (black box). Please note, however, that this will cause the session to be cleared and before the review can continued the session should be reloaded (see step 11).

Subsequent to these changes, the drive should be repacked and submitted to the portal.
SmartPile® Fix Utilities – Purge Sessions

Every unpacked Session is several megabytes (5-15 Mbytes) of blow data. Over time, unpacked drives can consume much of an available disk, and the Purge Sessions Utility allows users to review and completely delete Drive Sessions on the hard drive.

The Purge Session Utility lists all sessions in the current SmartPile Sessions directory (sorted by date with the oldest session at the bottom of the list). From here, the users can select and review the current storage requirements of any given session against the total storage available on the disk:

1. From the Session Listing, double click on a given Session to begin calculating the total storage; during the calculation the updating count will increment until all blows in the session have been accounted for (green box); once the calculation is complete the total storage to be freed up is displayed to the user along with the available storage and total disk size (red box).
2. Click the Purge Selected button to remove the Session and all associated blow data; this will automatically update the Session Listing and all Pile Statistics.
3. Continue the process until all Sessions to be purged are removed

Note:
It is recommended that the hard disk on the workstations is defragmented on a regular basis to improve acquisition performance.
Additional Capabilities
The SmartPile system has additional capabilities extending beyond the installation of driven piles; including:

- Measuring and recording the actual pre-stress of concrete pilings at the time of manufacture
- Monitoring and recording the actual skin vs. core thermal curing profile of pilings during manufacture
- Monitoring of the completed structure post construction
- Monitoring specific segments of piles (i.e. scour elevation to tip)
Download the SmartPile® Review Application

In order to download the latest version of the SmartPile® Review software, begin by accessing the Smart Structures Customer Portal (https://smartstructures.thingworx.com/Thingworx/).

If successful, you will be presented with a screen similar to that on the top right. Log in with your provided user account information, which will subsequently open the Main Portal Screen similar to that on the bottom right.

Click on the Download Link Icon on the right hand side of the Installer to begin the download process (red box). Make sure that you download the files first to your computer, and only then open them to install the program.
Part 4

Appendices
Appendix 1 – Background Paper

30 YEARS OF EXPERIENCE WITH THE WAVE EQUATION SOLUTION BASED ON THE METHOD OF CHARACTERISTICS

Peter Middendorp, Profound BV, Waddinxveen, the Netherlands

This paper was presented during GeoCongress 2006: Geotechnical Engineering in the Information Technology Age in Atlanta, GA.
30 YEARS OF EXPERIENCE WITH THE WAVE EQUATION SOLUTION BASED ON THE METHOD OF CHARACTERISTICS

Peter Middendorp, Profound BV, Waddinxveen, the Netherlands
Gerald E.H. Verbeek, VMS-Profound, Tyler, TX, USA

This paper will describe a brief history of the method of characteristics as an accurate solution of the wave equation, and the author's experiences with the method of characteristics over a period of 30 years.

As a result of the offshore pile driving activities associated with the development of the North Sea oil fields in the 1970's, two Dutch companies initiated extensive research efforts. Heerema started research the dynamic behavior of soil during driving and HBG (Hollandsche Beton Groep) extended the method of characteristics with a straightforward theoretical solution for the shaft friction along a pile.

The research institute TNO started the development of the wave equation program TNOWAVE in the late 1970's based on HBG's friction model extension for the method of characteristics. Today the program has a worldwide application in the field of pile testing. This paper will describe its development and application over time and its relation to today's applications for driveability studies for impact hammers (PDPWAVE) and vibratory hammers (VDPWAVE), signal matching for Dynamic Load Testing (DLTWAVE), Pile Integrity Testing signal matching (SITWAVE), and Static simulation (STNWAVE).

The paper will also highlight the algorithms behind the TNOWAVE program finally and identify areas for further development to enhance the capabilities of the TNOWAVE program.

Introduction

The Dutch author Jaap ter Haar once remarked that "he who lives in the present and doesn't know the past, floats aimlessly and dangerously into the future". In response to that observation Ter Haar spent 5 years in the early 1970's writing a series of four books covering the Dutch history from the prehistory to the then present. Having spent more than 30 years dealing with the Wave Equation Solution based on the Method of Characteristics, the author is regularly reminded how true this observation is. Engineers today take for granted Pile Driving Analysis (PDA) and Signal Matching Techniques to determine pile capacities, without realizing first that these techniques are relatively new, and secondly that they are the outcome of multinational and multi-disciplinary efforts.

Last year, during the 7th International Conference on the Application of Stress Wave Theory to Piles in Kuala Lumpur, Malaysia a paper was presented covering some of the author's experience with the method of characteristics with the focus on the algorithm used in TNOWAVE. This paper will expand on that topic by looking at the subject of the Wave Equation Solution application in pile foundation technology from a different angle: what can we learn from the developments in the recent past, not only to prevent us from floating aimlessly into the future, but more importantly to make us see more clearly how and in which areas to improve the current technology.

The Pre-History

In the 1880's a Frenchman, A.J.C Barre de Saint Venant, applied the principles of conservation of mass and momentum to the water flow in an open channel. The application resulted in two quasi-linear differential equations, for which de Saint Venant produced a theoretical solution, the so-called method of characteristics. This method was then used for a variety of hydrology
related issues, such as to predict the propagation of tidal waves, based on the work of J. Massau and J.C. Schonfield.

Starting in the 1930's Saint Venant's equations were applied to pile driving around the world, such as by L.H. Donnell in the United States, D.V. Isaacs in Australia, and W.H. Glanville in England. In 1938 the latter directed the first comprehensive study aimed at understanding cracking in concrete piles at both the top and the bottom during pile driving. As part of this work, measurements were taken during pile driving using what was considered at that time portable equipment in a construction trailer. As such Glanville is truly the pioneer in the field of PDA, as it would take some 10 years before similar work was done in the Netherlands (by A. Verduin in 1956) and some 25 years before it was done here in the United States (by G.G. Goble in 1964).

Just as Glanville can be considered the father of PDA, Isaacs can be considered the first to ever use wave equations for modeling pile driving. But apart from that, he should also be remembered for his insights on the issue of safety factors. In an article published in 1931 in the Journal of the Institution of Engineers Australia, Isaacs wrote the following on this subject:

It should be remembered, however, that these are not true factors of safety, but include a "factor of ignorance." The author suggests that when the ultimate resistance of any pile has been determined, in fixing the factor of safety...the most unfavorable conditions possible in the supporting strata should be judged (the range of conditions possible being narrowed with better knowledge of the subsurface conditions and of the possibility of disturbance from extraneous sources) and a proportion of the factor of safety — a "factor of ignorance" — then allowed in respect to these possible conditions, the manner of determining the ultimate load, and the type of loading to be borne. The remaining proportion of the factor of safety — or true margin of safety — should be approximately constant for all classes of loading and foundation conditions involving the same value of loss in case of failure; and the overall factor of safety...will then be equal to the

product of the true factor of safety with the "factor of ignorance." (p. 305)

This way of dealing with safety factors was and remains extremely insightful, and is just another example why it is important to know the past.

The original method of characteristics was valid for a free rod, not interacting with shaft friction or toe resistance. After all, the method is based on the phenomenon that stress waves propagate unaltered with a characteristic stress wave velocity. In 1956 Dutch scientist G. de Josseling de Jong proposed a model to incorporate the toe resistance into the method of characteristics (Fig. 1), and then in 1974 the Dutch company HBG extended the method by formulating the theoretical solution for piles with shaft friction. This development was part of HBG's development of the Hydroblok impact hammer, a high-tech hammer using nitrogen cushioning to improve efficiency.

Until 1974 when friction was introduced, the partial differential equation could only be solved analytically if the friction was represented as an analytical function. The solution was then found by integral transforms (such as the Laplace transform) and obtained in the form of Fourier series (Van Koten, et al. 1980). However, if the shaft friction was assumed to depend on the velocity or displacement, there was no theoretical solution and a numerical integration of the differential equation had to be used, as was done at that time in the numerical wave equation program developed by E.A.L. Smith. For this purpose the pile was modeled by a number of point masses, with the shaft friction and toe resistance introduced through a series of springs with dash-pots connected to the point masses (the so-called Lumped Model, Fig. 2).

Fig. 1. Toe resistance model for method of characteristics for low and high frequencies proposed by De Josseling de Jong (1956)
To be able to generate a theoretical solution, the HBGs took a different approach to account for the friction, which—with hindsight—was really very simple: "when the friction is concentrated at a number of points, the parts of the pile between these points are not subject to friction and the simple stress wave theory is valid for them," and the discontinuities that occur at the points where the friction is modeled can be easily dealt with. This method formed the basis for HBG's computer program PILEWAVE that was released in 1974, a few years before the WEAP program was released in the USA and TNOWAVE was released in The Netherlands.

**TNOWAVE**

Although it is a small country, The Netherlands has a huge piling market because of the poor soil conditions. Every year between 700,000 and 1,000,000 pre-cast piles are driven and a similar number of cast in situ piles are installed. It is therefore not surprising that there was a need for basic research in the area of pile foundations. Consequently in the 1980's a group was established within the Building and Construction Research Department of the Dutch organization for Applied Scientific Research (TNO), the second largest R&D organization in Europe. The Foundation Pile Diagnostic Systems (FPDS) Group, as it was initially called before it was renamed Profound, took on a broad range of activities for its clients in foundation pile testing with state-of-the-art technology that was developed in research and development projects.

In the 1970's this group started to really focus on the field of stress wave applications when two Dutch companies (Heerema and HBG) together with TNO intensified their research in this area because of the offshore pile driving activities associated with the development of the North Sea oil fields.

In 1975 Heerema performed research at the TNO laboratories to investigate soil behavior during pile driving to develop models for pile driveability analysis, elaborating on the work done by H.M. Coyle and G.C. Gibson in the United States. At the same time HBG used the stress-wave application in their development of the Hydroblok, which lead to the release of PILEWAVE in 1974.

Following the release of PILEWAVE, TNO wanted to develop its own wave equation program. While it was considered to use Smith's algorithm as the basis for such a program, it was decided to use the method of characteristics instead, and the first issue of the program TNOWAVE was released in 1978. In the following years much work was done to better understand the dynamic soil model parameters and to establish signal matching techniques, similar to CAPWAP. The first commercial version of the DLTWAVE module was released in 1982.

In the second half of the 1980's TNOWAVE was extended to vibratory pile driving prediction, again in response to developments in the offshore oil & gas industry. At that time the theories to predict the performance of a vibro-hammer were based on a single, lumped-mass pile model. This approach is valid for relatively short piles, but not for long piles (such as used offshore). A long pile is not moving as a single lumped mass, and stress wave phenomena have to be taken into account. Using the method of characteristics the VDPWAVE module was developed, and following its release in 1988 it was used to demonstrate that long offshore piles could be installed with vibro-hammers (Jonker & Middendorp, 1988).

From the above it is obvious that the early development of TNOWAVE was heavily affected by the offshore oil & gas industry (just as the United States Federal Highway Administration...
and the New York Department of Transportation had a strong influence on the development of the WEAP program in the United States). By the late 1980’s and early 1990’s there were several features added to the program to address needs in the pile foundation industry in general.

First, the Dutch pre-cast piling industry wanted to know the minimum amount of steel required to allow pile driving without loss of quality and reliability. Since the main function of the reinforcement is to prevent or at least reduce cracking during pile driving, a numerical crack model was developed and implemented into TNOWAVE in 1988. This model contains the following options:

- Simultaneous wave propagation in the concrete and the reinforcement
- Bond forces between concrete and reinforcement
- Pre-stressing
- Cracking models
- Multiple cracking
- Opening and closing of cracks

Secondly, around that same time the TNOWAVE signal matching technology was extended to pile integrity testing, and in 1988 the SITWAVE module was released. Later that year the module was successfully tested on piles with known defects.

Finally, in the early 1990’s the program was expanded one more time with the release of the STN WAVE module to cover the development of Statnamic testing, which was developed by TNO and Beringhammer. It is interesting to note that this module strictly speaking doesn’t belong in TNOWAVE. Given the long duration of the Statnamic test (compared to a dynamic load test) it was first assumed and later demonstrated that the pile could be modeled as a lumped mass with springs and that stress wave phenomena did not have to be taken into account.

**TNOWAVE Algorithm**

In the second half of the 1970’s, when TNO wanted to develop its own wave equation program, it was well known that the Smith algorithm gave approximate solutions and some major problems were known (van Weele, 1984):

- A falling ram with the same impedance as the pile did not result in a block shape wave in the pile as it should according to the theory
- A wave in a frictionless pile decreased in amplitude with depth because of numerical damping, while it should not. Furthermore the elements were not in rest after the wave front had passed, but still contained some energy, as they were vibrating.
- There was a limitation in the representation of higher frequencies: the higher the frequency, the larger the inaccuracies in the propagation of the wave.

---

Fig. 3. TNOWAVE models for Diesel and Hydraulic Hammers

---
In the case of large end resistance the solution could become unstable.

The algorithm proposed by HBG did not suffer from all these problems since it was based on a theoretical solution (the method of characteristics) and not on an integration procedure. Therefore TNO decided to pursue a wave equation program based on the method of characteristics. It should be noted that later studies proved that several of the problems of the Smith’s algorithm could be overcome by modifications to the spatial and temporal discretisation of the program, i.e. by introducing the critical time-step. (van Weele and Kay, 1984).

The algorithm that was finally developed can be summarized as follows (see also Fig. 4):
- The pile is divided into equally spaced intersections. The spaces between the intersections are called elements. The set of intersections common to each pair of spaces is to be considered as a coordinate system.
- The waves arriving at the intersections are determined from the waves calculated at the former time-step. Between the intersections the pile is frictionless and so the propagation of a wave will travel undisturbed. At each intersection a part of the wave will be transmitted and another part reflected.
- The magnitude of transmitted and reflected waves depends on the pile properties and the shaft friction. The equations for transmitted and reflected waves are derived from the fulfillment of equilibrium and continuity conditions at the intersections.
- Force, velocity, displacement and accelerations are calculated from the waves, and the outcome is then used for the calculation of energy and friction.
- Starting conditions like the velocity of the impacting ram ($V_{start}$) are introduced by defining initial waves at the start of the calculation process:

![Diagram of TNOWAVE Algorithm](image)

$$\nu(n,i) = \frac{f_{i-1}^{1} - f_{i+1}^{1}}{Z_{n+1}}$$

Velocity:

$$\nu(n,i) = \frac{f_{i-1}^{1} - f_{i+1}^{1}}{Z_{n+1}}$$

Acceleration:

$$\alpha(n,i) = (\nu(n,i) - \nu(n,i-1)) / \Delta t$$

Displacement:

$$u(n,i) = \sum \nu(n,i) \Delta t$$

Power:

$$P(n,i) = f(n,i) \nu(n,i)$$

Energy:

$$E = \sum P(n,i)$$

- Parts representing the ram, anvil, striker plates, helmet, hammer-caps, inserts, and followers are separated by
intersections that only transfer compression forces (no tension levels or splices). Hammer cushions and pile cushions are modeled as discrete springs or continuous parts. Diesel hammer combustion forces and Statnamic combustion forces are acting as external forces on the pile and ram or reaction mass. Vibratory hammer forces are also introduced as an external force on the pile top. In case of signal matching, a measured force signal is introduced on the pile top as an external force.

There are several possibilities to model the soil resistance, but those most frequently applied are presented in Fig. 6. In principle three different types of soil resistance models are available: displacement dependent resistance $W_d$ (modeled as springs), velocity dependent resistance $W_v$ (modeled as dash-pots), and acceleration dependent resistance $W_a$ (modeled as masses). The springs and dash-pots can be defined as linear and non-linear.

For static analysis (load displacement diagrams) only the stiffness of the pile elements and soil springs are taken into account.

The total friction $W_f$ acting at an intersection is then: $W_f = W_d + W_v + W_a$

The Future

It is clear that the stress-wave programs, such as TNOWAVE, have allowed and continue to allow lowering of the pile foundation costs. First, through the simulation mode it provides engineers the opportunity to optimize the design of both the pile itself and the pile foundation. Secondly, through the signal matching mode it allows the widespread use of dynamic load testing as well as Statnamic testing, which provide valuable information on the pile bearing capacity and therefore enable even further optimization of the pile foundation design.

However, these programs also have a distinct downside. In his address to the DFI Conference in Vienna in 1998 Heinz Brandl put it like this:

[Young engineers] frequently think that everything can be calculated, even to an accuracy of several decimal places. More and more, a so-called "point-and-click generation" of "white collar engineers" without sufficient site experience is emerging.

The geotechnical profession must remain fully aware of this downside and ensure that the practitioners in this field continue to have a good basic understanding of the theory behind the tools of the trade.

With that understanding comes a realization that the current stress-wave programs must continue...
to be developed, which as an aside can only be done by people who do have this good basic understanding of the theory. Some of these developments will be considered (at least with hindsight) so obvious that future engineers will wonder why it took so long before they took place, just as it is now blatantly obvious how pile friction should be dealt with in the stress-wave program.

One area that can never be overlooked is soil modeling. While the TNOWAVE soils investigation module handles many different types of soil investigations, this part is undoubtedly the weakest link in the overall hammer-pile-soil model. To borrow a phrase from Isiacs, the factor of ignorance is the greatest in the soil modeling, and therefore research efforts should be directed towards this area, making full use of the ever increasing computing capabilities. In this regard the efforts in the Netherlands surrounding the Geotechnical Exchange Format (GEF) should be noted. Soil investigation data (like CPT results) are recorded in a standardized digital format (GEF) and the TNOWAVE program can than read these GEF files, after which the soil investigation module automatically determines the soil types and then converts the soil investigation data into the fundamental static and dynamic soil parameters used in the algorithms.

As engineers we need to keep pushing the envelope for these developments to take place, but at the same time we need to keep a close eye on other disciplines. We need to remember that the basic equations used in the stress-wave programs did not come from geotechnology. In other words, the next big development may already be out there, waiting for a geotechnical engineer to apply it to pile foundations.

Similarly we need to be open to developments elsewhere in the world. Many engineers work for companies with international operations, which provides ample opportunity for interaction with engineers of other nationalities. The internet allows easy communication with people around the world, either through e-mail or message boards such as GeoForum. Once again, the problem at hand may not only have been encountered by another engineer, but the solution may already have been developed.

After all, the pile driving application of the wave equation solution based on the methods of characteristics is the result of multi-national and multi-disciplinary efforts, and any substantial developments are more than likely to come from similar efforts like that rather than from a narrowly focused effort.

References


De Josselin De Jong, G. 1956, “Wat gebeurt er in de grond tijdens het heien” (What happens in the soil during pile driving) De Ingenieur, No. 25, Breda, The Netherlands,

Esposito, G., Courage, WMG, van Fooken, R.J., 2000, Application of Stress Wave Method to Automatic Signal Matching and to Static Load Predictions. Sixth International Stress Wave Conference, Sao Paulo, Brazil


Heerema, E.P., 1979, Relationships between wall friction displacement velocity and horizontal stress in clay and in sand for pile drivability analysis. Ground Engineering


Jonker, G., Middendorp, P., 1988, Subsea installations using Vibratory piling hammers, 20th OTC, Houston, Texas

Jonker, G. Fooken van, R.J., 2000, Hammer and pile cushion optimization, Sixth International Stress Wave Conference, Sao Paulo, Brazil


Middendorp, P., Reiding, F.J., 1988, Determination of Discontinuities in Piles by TNO Integrity and Signal Matching Techniques. 3rd International Conference on the Application of Stress Wave Theory on Piles, Ottawa, Canada


Schoenfeld, J.C., 1951, Voortplanting van getijden en soortgelijke golven (Dutch) Propagation of tides and similar waves. Thesis University of Delft, The Netherlands


Verduin, A., 1956 “Spanningsmetingen tijdens het heien verricht aan een drietal heipalen voor Pier 1 de Waalhaven” (Stresswave measurements during the driving of three piles for Jetty 1 of the Harbor (Rotterdam)) TNO Rapport Nr. 341, Delft, The Netherlands.

A Short History of the Wave Equation for Piles, www.vulcanhammer.net/wave/developm.php

www.geoforum.com
Appendix 2 – Interpretation of SmartPile™ EDC Measured Pile Integrity (MPI) Results

Introducing Measured Pile Integrity (MPI)

The SmartPile™ EDC system uses the output value MPI (Measured Pile Integrity) to report on the concrete pile integrity. MPI is a composite function that uses two parallel and independent analysis methods:

- The first based on the traditional detection of change in pile impedance \( Z_2/Z_1 \) using a Wave Up analysis method (similar to the PDI BTA method)
- The second based on changes in the pre-load stresses in the concrete pile as measured by the embedded instrumentation (specifically the top and tip strain gauges)

Pile Impedance Based Damage Analysis

The change in pile impedance interpretation \( Z_2/Z_1 \) is based on a signal analysis technique of the Wave Up signal involving a search for abruptly occurring waveform artifacts during the time that the stress wave travels from the top of the pile to the tip and back up to the top \( (0 \leq T \leq 2L/c, \text{ with } L \text{ the length of the pile and } c \text{ the wave speed}) \). The magnitude of any detected anomalies is appropriately weighted and the impedance ratio \( \left( Z_{\text{new}}/Z_{\text{old}} \right) \) is reported as a percentage, albeit that any values less than 51 are reported as 0. This is based on the fact that any values below 60% already indicate significant issues with the pile, with the actual value providing little to no additional insight.

It is important to note that the change in pile impedance damage analysis approach is most effective in detecting horizontally oriented defects that affect the pile cross section (such as in the case of tension cracks), and is NOT meant to provide any insight into vertically oriented material damage unless or until the damage results in a reduction in cross sectional area.

The method of pile impedance based damage detection is most effective during “softer” driving (which creates higher tension stresses in the pile) because during “harder” driving damage is more likely near the pile tip due to the increase in the compressive stresses in the pile (to basically double the original value when driving into very hard material).

While the interpretation of these values is subjective, it is obvious that as the reported MPI values deviate further from 100% the likelihood of pile damage increases. Generally speaking, results interpretation of the pile impedance based damage analysis is recommended as follows:

- 100% - No issues detected regarding a change in pile impedance
- 99% - 80% - Minor signal issues detected possibly indicating slight pile damage
- 79% - 60% - More significant issues detected indicating possible pile damage
- Less than 60% - Major issues detected, seek qualified professional assessment
Pre-Stress Based Damage Analysis

An alternate material integrity analysis method involving the monitoring of static pre-stress levels (specifically changes) within the core of the concrete material yields a different level of insight regarding the structural integrity of the pile. Because the embedded strain instrumentation is positioned in the pile core prior to pile casting and subsequent pre-stressing, the instrumentation can monitor the pre-stress levels, even at the pile tip, which for obvious reasons cannot be monitored once pile driving has started. But it is at this very location where the pile is subject to the greatest compressive stresses, shear stresses, and stress gradients within the foundation element during installation.

The pre-stress levels in a pre-tensioned pre-stressed concrete pile are established as the result of two directly opposing forces reaching equilibrium. The first being the tensile stress in the steel strands multiplied by the total cross-sectional area of these strands; and the second the compressive stress in the concrete multiplied by the total cross-sectional area of the concrete. Once this equilibrium condition and corresponding pre-stress level is established, any change in either force will upset this balance and result in a new equilibrium (and therefore new pre-stress level).

For example, a vertically oriented crack extending up from the pile tip is very likely to upset this balance. When viewed looking into the pile end (see Figure 1), separate concrete sections will result, with the resulting pre-stress level in each section determined by the section’s cross-sectional area and the number of steel strands in that section. Consequently any vertical crack resulting in non-symmetric volumes will result in some sort of pre-stress shift, with a complete loss of pre-stress potentially indicating the complete loss of bonding between the steel and the concrete from the pile tip up to the location of the strain gauge. It should be noted, however, that any change in the static pre-stress levels, especially a reduction or relaxation in the concrete compressive static stress levels during pile driving, especially a reduction in the concrete compressive stress levels, should be considered a possible leading indicator of high stresses near the pile tip.

Please note that an increased compressive residual force could be the result of the pile weight of the pile plus any below grade soil shaft friction forces preventing tip rebound from a hammer blow.

Figure 1: Orientation of vertical cracking
The monitoring of the changes in pile internal pre-stress levels is accomplished by measuring and tracking the static pre-stress equilibrium levels for every hammer blow measured after the dynamic strain events have dissipated or settled out. With the raw offset strain values available for display in the Raw Data analysis tab of SmartPile™ Review, any reported change in the measured static pre-stress values are clearly evident in the strain signal presentation during data playback.

If the recorded change in pre-stress level drops the equivalent of more than 50 microstrain for 10 consecutive blows, than is it assumed and reported that pile damage has occurred. In all other cases, it is assumed that the pile is intact.

**Interpreting Measured Pile Integrity values**

The reported MPI value is basically the calculated change in impedance output, reduced by 50 if the pre-stress based damage analysis indicates pile damage. So for example, if the detected change in pile impedance is calculated to be worth 12 points, MPI can report either an 88% (100-12) or a 38% (100-12-50) depending on whether the pre-stress based damage analysis indicates any damage to the pile.

The reported “Measured Pile Integrity” (MPI) values can then be described as follows:

<table>
<thead>
<tr>
<th>MPI</th>
<th>Pile Impedance based damage analysis</th>
<th>Pre-stress based damage analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 %</td>
<td>No issues detected</td>
<td>No Issues detected</td>
</tr>
<tr>
<td>99 – 80 %</td>
<td>Minor signal issues detected possibly indicating slight pile damage</td>
<td>No Issues detected</td>
</tr>
<tr>
<td>79 – 60 %</td>
<td>More significant issues detected indicating possible pile damage</td>
<td>No Issues detected</td>
</tr>
<tr>
<td>59 -51 %</td>
<td>Major issues detected indicating likely pile damage; seek qualified professional assessment</td>
<td>No Issues detected</td>
</tr>
<tr>
<td>50 %</td>
<td>No issues detected</td>
<td>Issues detected indicating likely pile damage; seek qualified professional assessment</td>
</tr>
<tr>
<td>49-30 %</td>
<td>Minor signal issues detected possibly indicating slight pile damage</td>
<td>Issues detected indicating likely pile damage; seek qualified professional assessment</td>
</tr>
<tr>
<td>29 – 10 %</td>
<td>More significant issues detected indicating possible pile damage</td>
<td>Issues detected indicating likely pile damage; seek qualified professional assessment</td>
</tr>
<tr>
<td>9 – 0 %</td>
<td>Major issues detected indicating likely pile damage; seek qualified professional assessment</td>
<td>Issues detected indicating likely pile damage; seek qualified professional assessment</td>
</tr>
</tbody>
</table>
Interpretation Examples

A measured shift in the reported static pre-load value if detected is a composite of three potential sources:

1. Residual compressive stresses
2. Compromised or relaxed pre-stress (tension)
3. Any unsettled dynamic wave propagation (error)

The system software accounts for the third as described below, with any resultant reported measurement shift being a summation of the remaining two. The specific error condition being monitored for is a relaxation of the static compressive pre-load.

To help prevent large negative reported pre-load delta values, the SmartPile™ algorithm takes a baseline measurement at the beginning of a blow at the pile tip and determines if any residual negative movement was present and detected at the end of the previous blow. Any reported delta measurement is then adjusted accordingly. For this very reason, stepping through blows backwards vs. forwards in SmartPile™ Review will affect the reported pre-load delta values and must be avoided. Before acting on large negative reported static pre-load delta shifts, move to the Raw Data analysis tab and look for unsettled wave propagation on the tip strain at the end of recorded blows. Check and confirm that the dynamic strain events have settled out, as it is easier to assess reported conditions when all dynamic events have settled out to zero by the end of the blow.

In softer driving, which is common during the initial part of the pile driving, tip strain readings don’t always return to zero by the end of the blow as shown in Figure 2 below (red arrow). When soil conditions tighten up, the dynamic tip strain measurements settle out to zero by the end of the blow, as seen in Figure 3.

Unsettled Tip Strain

Figure 2: Unsettled tip strain (blue) wave propagation at the end of blow

Figure 3: Settled tip strain (blue) wave propagation at the end
Use of Tip Stresses as a leading indicator of pile damage

In Figure 4 the change in static strain (pre-stress) reading at the top and the tip of the pile are shown (left vertical axis in microstrain) as well as the compressive stresses (CSB) at the tip (right vertical axis in ksi), all as a function of the blow count (horizontal axis).

As can be seen from a report generated with SmartPile™ Review, around blow count 1500 the pile penetrates a hard soil layer, causing the compressive stresses measured at a point in the tip core to increase to approx. 1.6 ksi. At the same time the static tip strain (pre-stress) begins to fall and eventually drops some 50 microstrain, indicating likely damage to the pile tip.

![Graph showing measured CSB (magenta) plotted with top (green) and tip (blue) pre-load deltas. Note the loss of pre-stress occurring right after punching through a hard layer (~1.55 KSI) resulting in an eventual pre-stress relaxation of approximately 50 microstrains (red line).](image)

It should be noted that the pile tip compressive stresses are NOT necessarily uniformly distributed, and may contain VERY large localized shear stress gradients distributed anywhere across the pile tip cross sectional area. Although the gauge mounted in the center of the pile may not actually record the maximum compressive stress experienced by the pile tip, the gauge IS adequately positioned to measure any localized changes in compressive material pre-load.
Case Study – US19 over Barge Canal, Pier3 Pile2; anatomy of a failure

This case study illustrates a scenario whereby the measured pre-stress was completely lost at the tip of the pile. A subsequent extraction of that same pile confirmed the damage to the tip as detected and reported through MPI. It should be noted that, except for a few individual blows, the pile impedance based damage analysis did not indicate any damage to the pile.

Figure 5: Tip (blue) and Top (green) measured pre-load deltas (above), and corresponding reported MPI values (below)
Figure 6: Example of material disturbance. Driven pile referenced from data above after extraction. Vertical cracks extend 10 feet up from the pile tip as noted by the visible ends of the tape measure. The tip instrumentation located in a segmented mass within pile core remained operational.

The SmartPile™ Measurement System - Components and Design

Regarding any data analysis approach, it is important to note that the quality of the measured data is only as good as the design and implementation of the measurement system. The SmartPile™ EDC foil-based embedment gauge is manufactured and sealed in a controlled environment to address the bonding and sealing concerns that are common for gauges embedded in concrete. The external package is of a special contoured design to ensure that proper bonding is established and maintained with the material under test. To optimize measurement precision, the EDC embedment gauge utilizes the latest foil resistor technology; leveraging the latest state of the art resistor grade metal alloys for better long term stability. The foil resistor design also provides for precise thermal compensation using a proprietary approach to negate any gauge thermal output effects throughout the normal operating temperature range of the sensor.

To address the front end signal conditioning design requirements; the SmartPile™ EDC system utilizes the latest state-of-the-art, low power, high performance instrumentation design, layout, and military standard fabrication practices. Instrumentation grade components are carefully selected to ensure both precision and stability. The result is an active strain sensing and measurement system with built-in thermal compensation that can withstand the rigors of concrete casting, curing, and deep foundation installation process.
Conclusion

During pile driving it is important to continually consider the pile integrity, especially during hard driving conditions. Quite often this is done based on a pile impedance based damage analysis, but the SmartPile™ EDC system includes a second and completely independent analysis method: the pre-stress based damage analysis. If either of these analysis methods indicates that damage of the pile tip is likely, it is strongly suggested to seek a qualified professional assessment to determine how to proceed.
Appendix 3 – SmartPile™ EDC Reports

SmartPile Review can generate two types of reports: a Standard Format Report, which produces an Excel spreadsheet with a tabular display of all the pertinent project information or a DOT Format Report, a nicely formatted Excel spreadsheet with both tabular and graphical displays of the pertinent data.

On the following pages a sample copy of a DOT Format Report has been included for illustration purposes.
### User Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Phillip Terry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>APT</td>
</tr>
</tbody>
</table>

### Project Information

<table>
<thead>
<tr>
<th>Project Name</th>
<th>SR1121093</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Miami</td>
</tr>
<tr>
<td>County/Decade</td>
<td>Miami-Dade 06</td>
</tr>
<tr>
<td>Project Number (SOE)</td>
<td>MAPLE 1.0.64</td>
</tr>
<tr>
<td>Project Description</td>
<td>SR1121093 from East of I-95 to Hialeah Bay</td>
</tr>
<tr>
<td>Site Location</td>
<td>Miami</td>
</tr>
<tr>
<td>Roadway</td>
<td>SR1121093</td>
</tr>
</tbody>
</table>

### Notes

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>FOR EVALUATION PURPOSES ONLY</td>
</tr>
</tbody>
</table>

### Data Review Manual

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>Data Review Manual</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision 4.0</td>
</tr>
</tbody>
</table>

---

**Average of identified displacement values for a slope bias & individual influence in feet (e.g., Tensile) 2014**

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SR1121093</td>
<td>Plan 3</td>
</tr>
<tr>
<td>Plan</td>
<td>3</td>
</tr>
<tr>
<td>For Evaluation Purposes Only</td>
<td>2014</td>
</tr>
</tbody>
</table>

---

**Additional Information**

<table>
<thead>
<tr>
<th>Item</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartPile™ EDC Report</td>
<td>SmartPile™ EDC Report</td>
</tr>
<tr>
<td>Tip Direction (up)</td>
<td>Blow Number</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>22:44</td>
<td>578</td>
</tr>
<tr>
<td>22:45</td>
<td>576</td>
</tr>
<tr>
<td>22:46</td>
<td>577</td>
</tr>
<tr>
<td>22:47</td>
<td>580</td>
</tr>
<tr>
<td>22:48</td>
<td>576</td>
</tr>
<tr>
<td>22:49</td>
<td>577</td>
</tr>
<tr>
<td>22:50</td>
<td>580</td>
</tr>
<tr>
<td>22:51</td>
<td>576</td>
</tr>
<tr>
<td>22:52</td>
<td>577</td>
</tr>
<tr>
<td>22:53</td>
<td>580</td>
</tr>
<tr>
<td>22:54</td>
<td>576</td>
</tr>
<tr>
<td>22:55</td>
<td>577</td>
</tr>
<tr>
<td>22:56</td>
<td>580</td>
</tr>
<tr>
<td>22:57</td>
<td>576</td>
</tr>
<tr>
<td>22:58</td>
<td>577</td>
</tr>
<tr>
<td>22:59</td>
<td>580</td>
</tr>
<tr>
<td>22:60</td>
<td>576</td>
</tr>
<tr>
<td>22:61</td>
<td>577</td>
</tr>
<tr>
<td>22:62</td>
<td>580</td>
</tr>
<tr>
<td>Depth (ft)</td>
<td>Blow Count</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>-12</td>
<td>9</td>
</tr>
<tr>
<td>-13</td>
<td>11</td>
</tr>
<tr>
<td>-14</td>
<td>13</td>
</tr>
<tr>
<td>-15</td>
<td>14</td>
</tr>
<tr>
<td>-16</td>
<td>17</td>
</tr>
<tr>
<td>-17</td>
<td>20</td>
</tr>
<tr>
<td>-18</td>
<td>22</td>
</tr>
<tr>
<td>-19</td>
<td>25</td>
</tr>
<tr>
<td>-20</td>
<td>25</td>
</tr>
<tr>
<td>-21</td>
<td>26</td>
</tr>
<tr>
<td>-22</td>
<td>30</td>
</tr>
<tr>
<td>-23</td>
<td>30</td>
</tr>
<tr>
<td>-24</td>
<td>23</td>
</tr>
<tr>
<td>-25</td>
<td>24</td>
</tr>
<tr>
<td>-26</td>
<td>22</td>
</tr>
<tr>
<td>-27</td>
<td>22</td>
</tr>
<tr>
<td>-28</td>
<td>21</td>
</tr>
<tr>
<td>-29</td>
<td>25</td>
</tr>
<tr>
<td>-30</td>
<td>30</td>
</tr>
<tr>
<td>-31</td>
<td>29</td>
</tr>
<tr>
<td>-32</td>
<td>29</td>
</tr>
<tr>
<td>-33</td>
<td>27</td>
</tr>
<tr>
<td>-34</td>
<td>23</td>
</tr>
<tr>
<td>-35</td>
<td>20</td>
</tr>
</tbody>
</table>

**Blow Count**

- **Pipe 1**
  - Depth: -12 to -15
  - Count: 9 to 14

- **Pipe 2**
  - Depth: -16 to -20
  - Count: 20 to 25

- **Pipe 3**
  - Depth: -21 to -25
  - Count: 21 to 25